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Začíname
Príprava ochrany vašej firemnej siete pomocou ESET Endpoint Antivirus / 
ESET Endpoint Security je proces, ktorý sa dá zvládnuť za jedno odpoludnie. 
Tento sprievodca vás prevedie základnými nastaveniami - od získania vášho 
bezpečnostného produktu ESET, cez konfiguráciu vášho servera a mirroru, inštaláciu 
programu na klientské počítače až po prispôsobenie klientských nastavení. Je 
to stručný sprievodca, ktorý neobsahuje všetky detaily týkajúce sa inštalácie a 
konfigurácie, a preto odporúčame prečítať si používateľské príručky k jednotlivým 
produktom. V procese vzdialenej inštalácie je dôležitá najmä príručka k ESET Remote 
Administrator. Odporúčame používať ju kedykoľvek je to potrebné počas inštalácie.

Softvérové komponenty
Váš bezpečnostný softvér má 3 samostatné časti: samotný ESET Endpoint Antivirus/
ESET Endpoint Security, ESET Remote Administrator Console (ERAC) a ESET Remote 
Administrator Server (ERAS). Konzola (ERAC) by mala byť nainštalovaná na počítači 
(počítačoch), z ktorého (ktorých) chcete spravovať svoju sieť. Server (ERAS) by mal 
byť nainštalovaný na vašom serveri. V menších sieťach je obvykle server aj priamo ten 
istý počítač, z ktorého samotnú sieť spravujete.

Sekcia 1: Kúpa a stiahnutie vášho softvéru
Prvý krok k ochrane vašej siete je získanie všetkých troch komponentov spomínaných 
vyššie. Ak ste si ešte nezakúpili váš ESET bezpečnostný produkt, kliknite na tento link:

http://www.eset.com/sk/obchod

Ak ste si už zakúpili váš bezpečnostný produkt ESET, obdržíte oficiálny e-mail od 
spoločnosti ESET, ktorý bude obsahovať vaše používateľské meno a heslo v texte 
e-mailu a váš licenčný súbor v prílohe e-mailu.

1.1 Používateľské meno a heslo

Vaše používateľské meno a heslo sa líšia od iných mien a hesiel ktoré vám môžu byť 
známe. Sú to prednastavené kľúče ktoré chránia vaše údaje. Sú to autentifikačné 
kľúče, pomocou ktorých sa pripájate na servery spoločnosti ESET, umožňujú vám 
sťahovať bezpečnostné produkty spoločnosti ESET a následne ich aktualizácie. Toto 
meno a heslo si nemôžete preto zvoliť ani zmeniť.

Počas prvotných nastavení ESET servera a Endpointových produktov budete 
niekoľkokrát vyzvaní pre zadanie používateľského mena a hesla. Zadajte ich opatrne. 
Obe rozlišujú veľké a malé písmená a čiarka v používateľskom mene je povinná. 
Vaše používateľské meno sa skladá z 10 znakov (všetky písmená sú malé); ak sa 
rozhodnete kopírovať a vložiť vaše používateľské údaje z licenčného e-mailu, uistite 
sa že ste vymazali všetky nadbytočné medzery, ktoré môžu byť interpretované ako 
znaky. Vaše heslo nebude nikdy obsahovať “L”, je to numerická jednotka (1). Veľké “0” je 
numerická nula. Malé “o” je písmeno “o”.

1.2 Licenčný súbor

Váš licenčný súbor – príloha pomenovaná nod32.lic – je súbor, ktorý ESET Remote 
Administrator potrebuje na správu vašej siete chránených klientov. Obsahuje 
autentifikáciu pre určitý počet počítačov (chránených počítačov) a hovorí ESET 
Remote Administrator-u, že máte oprávnenie chrániť a spravovať určitý počet 
počítačov podľa balíka, ktorý ste si zakúpili. Uložte si váš licenčný súbor na pracovnú 
plochu.

1.3 Získanie vášho softvéru

Pre prístup do sekcie Na stiahnutie kliknite na link nižšie. Získate tri hlavné 
komponenty: 

http://www.eset.sk/download

Kliknite na záložku Firmy a potom na kategóriu Remote management. Stiahnite si 
oba komponenty (ERA Server a ERA Console). Potom kliknite na kategóriu Endpoint 
Security a stiahnite si váš zakúpený bezpečnostný produkt. Vo všetkých troch 
prípadoch budete vyzvaní na zadanie vašich prihlasovacích údajov.

Odhadovaný čas:          30 minút

ESET Endpoint Antivirus/ESET Endpoint Security, 
ESET Remote Administrator Server a ESET Remote 
Administrator Console sú 3 piliere, na ktorých stojí 
vaša ochrana proti škodlivému softvéru: samotný 
antivírus; server, ktorý ho posiela na klientov a 
konzola, pomocou ktorej monitorujete svoj systém.

Príklady Používateľského mena a hesla: .
Používateľské meno: EAV-12345678.
Heslo: 1a2bc3defg

Prepojenie s KB článkami
Prečítajte si KB článok na ESET Knowledgebase:

Ako využijem licenčné súbory jednotlivých 
produktov ESET?.
.
http://kb.eset.com/esetkb/SOLN2253

Prepojenie s KB článkami
Prečítajte si KB článok na ESET Knowledgebase:

Ako pridám do produktu ESET Remote 
Administrator nový licenčný súbor?

http://kb.eset.com/esetkb/SOLN540

http://kb.eset.com/esetkb/SOLN2253
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Sekcia 2: Inštalácia
Ak už máte všetky tri súbory stiahnuté (štyri, v prípade stiahnutia aj 64-bitovej 
verzie), všetko je pripravené na inštaláciu. Sekcia 2.1 až 2.3 predpokladá, že používate 
32-bitové inštalačné súbory. Ak používate 64-bitové, názvy súborov budú mierne 
odlišné.

2.1 ESET Remote Administrator Server

Začnite dvojklikom na inštalačný súbor .msi pre ESET Remote Administrator Server 
(era_server_nt32_enu.msi).

Kliknite na End-User License Agreement a potom na Next. Zvoľte typickú inštaláciu 
a kliknite na Next. Program vás vyzve na zadanie licenčného súboru 
nod32.lic (ktorý ste si uložili na pracovnú plochu).

Program vám ponúkne možnosť zadať heslá pre rôznych klientov a rôzne servery 
vo vašej sieti. Pretože sa snažíme inštaláciu zjednodušiť, tu zadáte iba jedno heslo, 
Password for console (Administrator Access). Toto heslo chráni váš prístup 
k správe siete. Kliknite na Set a zvoľte si silné a bezpečné heslo, ktoré si zapamätáte 
a nešírte ho ďalej. (Neskôr sa môžte k tomuto kroku vrátiť a zadať aj ostatné heslá, 
ak je to potrebné.) Kliknite na Next.

V poslednom kroku zadajte svoje používateľské meno a heslo pridelené 
spoločnosťou ESET (rovnako ako vo webovej autentifikácii v kroku 1.3.1). Zadajte 
ich a kliknite na Next. Taktiež môžte svoje používateľské meno a heslo skopírovať 
z licenčného mailu a vložiť sem. Kliknite na Next a objaví sa ukazovateľ pokroku 
inštalácie.

Po dokončení inštalácie sa služba ESET Remote Administrator Server spustí 
automaticky. 

2.2 ESET Remote Administrator Console

Ked už je ESET Remote Administrator Server nainštalovaný, pokračujte dvojklikom 
na inštalačný súbor ESET Remote Administrator Console (era_console_nt32_enu.msi). 
Nainštalujte konzolu na počítač, odkiaľ plánujete spravovať svoju sieť. Najčastejšie 
to je lokálny počítač, kde spúšťate inštalačné súbory. Zvoľte typickú inštaláciu  
a pokračujte cez možnosti klikaním na tlačidlo Next kým ho nenahradí tlačidlo 
Install. Objaví sa ukazovateľ priebehu inštalácie.

2.3 Ďalšie možnosti 

Keďže toto je rýchly sprievodca inštaláciou ESET Remote Administrator, preskočíme 
veľké množstvo nastavení a možností, ktoré si môžete prejsť neskôr. 

Pre dodatočné informácie ohľadom inštalácií na MS SQL, MySQL alebo Oracle 
serveri a pre zoznam TCP portov, ktoré musia byť otvorené pre správne fungovanie 
ESET Remote Administrator-a, prejdite na Sekciu 2 Inštalačného manuálu pre ESET 
Remote Administrator.

Odhadovaný čas:          15 minút

DÔLEŽITÉ: ESET Remote Administrator Server inštalujte 
na server, ktorý bude spravovať vašu sieť. Môže to byť  
lokálna stanica, na ktorej pracujete, ale môže to byť aj 
server v racku alebo server umiestnený inde. Kontaktujte 
svojho sieťového administrátora, ak si nie ste istý.

ERA Príručka
Pre viac informácií si prečítajte v používateľskej 
príručke ESET Remote Administrator tieto 
kapitoly:  
 
2.1.3	 Použité porty 

2.2	 Základná príručka inštalácie

Prepojenie s KB článkami
Prečítajte si KB článok na ESET Knowledgebase:

Ktorú verziu (32-bit alebo 64-bit) produktov ESET 
Endpoint by som mal stiahnúť? (5.x)

http://kb.eset.com/esetkb/SOLN3013

http://kb.eset.com/esetkb/SOLN3013
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Sekcia 3: Nastavenie Mirror servera
Vaše klientské počítače chránené antivírusom od spoločnosti ESET si pravidelne 
aktualizujú vírusovú databázu z aktualizačných serverov ESET. Toto ich udržuje 
chránené pred rôznymi hrozbami. Ponechať ale všetky klientské počítače, aby sa 
aktualizovali nezávisle od seba, by viedlo k vyššej záťaži vašej lokálnej siete (LAN)  
a pripojeniu k internetu.

Riešením je vytvorenie Mirror servera (server, ktorý odzrkadľuje aktualizačné servery 
spoločnosti ESET) vo vašej sieti LAN, takže počítače budú sťahovať aktualizácie len  
v rámci vašej siete.

 3.1 Nastavenie Mirror servera

Otvorte konzolu ESET Remote Administrator kliknutím na Start → All Programs 
→ ESET → ESET Remote Administrator Console → ESET Remote Administrator 
Console. Uistite sa, že je konzola spojená so serverom (File → Connect).

V tejto príručke nastavíme štandardný mirror server pomocou interného http 
protokolu. Sú dostupné aj iné možnosti, vrátane nastavenia lokálneho adresára na 
ukladanie aktualizácií, ako aj inštrukcie pre vytvorenie rôznych mirror serverov pre 
rôzne siete. Pre viac informácií kliknite na KB článok na pravej strane.

Odhadovaný čas:          15 minút

Objaví sa dialógové okno Event fired on the server. Táto správa znamená, že váš 
mirror server sa úspešne prihlásil na servery spoločnosti ESET a stiahol najnovšie 
aktualizácie. Kliknite na OK.

3.2 Otestujte svoj mirror

Overte si, či váš nový mirror server funguje. Otvorte si internetový prehliadač na 
klientskom počítači (nie na serveri) a zadajte:

http://Testserver:2221/update.ver
(Testserver je názov vášho servera)

Ak bol váš mirror vytvorený úspešne, uvidíte textový súbor s informáciami o vašom 
mirrore (obrázok 2-1 napravo). Ak bolo vytvorenie neúspešné, objaví sa štandardná 
chybová hláška o neúspešnom spojení so serverom.

3.3 Nastavenie protokolov na serveri

Pre zachovanie kompaktnosti databázy a optimalizáciu výkonu, ESET Remote 
Administrátor štandardne neukladá protokoly z HIPS, Správy zariadení, Ochrany 
prístupu na web, Antispamu alebo Greylistingu.

V okne Server Options môžete povoliť zapisovanie protokolov z týchto aktivít. 
Kliknite na Tools → Server Options a následne na záložku Server Maintenance. 
Kliknite na Log Collecting Parameters a nastavte úroveň zapisovania protokolov 
pre jednotlivé funkcionality z rozbaľovacieho menu. Po nastavení kliknite OK pre 
potvrdenie.

Prepojenie s KB článkami
Prečítajte si KB článok na ESET Knowledgebase: 
 
Aké spôsoby aktualizácie vírusovej databázy sú 
možné cez ESET Remote Administrator?

http://kb.eset.com/esetkb/SOLN2337

Kliknite na Tools → Server Options. Kliknite na záložku Updates 
a zadajte svoje používateľské meno a heslo od spoločnosti ESET 
do koloniek Update Username a Update Password v okne 
Server Options (Obrázok 1-1, na pravej strane). Kliknite na Set 
Password... pre zadanie vášho hesla.

Zaškrtnite možnosť Create update mirror v strede okna. Taktiež 
zaškrtnite možnosť Provide update files via internal HTTP pod 
ňou.

Kliknite na tlačidlo Update now a zobrazí sa potvrdzujúce okno 
(This will first apply server options and then fire the event. 
Continue?) Kliknite na Yes.

Obrázok 2-1: Stránka z programu Windows Internet Explorer 
zobrazujúca text úspešného pripojenia na Mirror server

Obrázok 1.1 : Okno Server Options

Prepojenie s KB článkami
Prečítajte si KB článok na ESET Knowledgebase:

Ako nainštalujem ESET Remote Administrator s 
konfiguráciou Mirror servera? (5.x)

http://kb.eset.com/esetkb/SOLN2993

http://kb.eset.com/esetkb/SOLN2337

http://kb.eset.com/esetkb/SOLN2993
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4.1 Ochrana nastavení

Našim cieľom je zabezpečiť, aby nastavenia vo vašich ESET klientských 
riešeniach nemohol modifikovať každý, iba administrátor alebo oprávnené 
osoby. V ESET Configuration Editore, úplne hore, kliknite na Windows 
Desktop v.5 → Kernel →  Settings → Protect setup parameters.

Ak je vysvietená možnosť Protect setup parameters, kliknite na Mark na 
pravej strane. Dvojklikom na možnosť Password to unlock: <Password 
is not set> ju otvoríte a budete vyzvaný na zadanie hesla, pomocou 
ktorého môžte meniť nastavenia na jednotlivých klientských počítačoch. 
Odporúčame zvoliť si heslo odlišné od hesla z kroku 2.1. Ak nastavíte toto 
heslo, každý, kto bude chcieť meniť nastavenia bezpečnostného softvéru 
ESET na klientoch, bude vyzvaný na jeho zadanie.

POZNÁMKA: Toto nastavenie ovplyvní iba zmeny nastavení u klientov. Ako 
administrátor môžte stále meniť nastavenia pomocou ERA konzoly  
a nebudete vyzvaný na zadanie hesla.

4.2 Deaktivujte úvodný obrázok a menej dôležité upozornenia 

V tomto kroku chceme dosiahnúť, aby klienti neboli upozorňovaní na 
aktivity ESET Endpoint Antivirus / ESET Endpoint Security, ktoré bežia v 
pozadí. V ESET Configuration Editor sa nastavte na Windows desktop v5 
→ Kernel →Settings → Default user interface values. Kliknite na Suppress 
user settings a prejdite na možnosť Value: Yes / No. 

Týmto zabezpečíte, že tieto nastavenia budú nadradené všetkým, ktoré 
by mohol nastaviť používateľ. Ďalej, prejdite na Show splash-screen 
at startup a na pravej strane odkliknite možnosť Value: Yes / No. Na 
koniec, kliknite na možnosť Display only notifications requiring user 
intervention a na pravej strane zvoľte možnosť Value: Yes / No. Práca 
používateľov na ich počítačoch nebude prerušovaná menej dôležitými 
hláseniami z ich antivírového softvéru.

4.3 Nastavenie aktualizácií klientov z mirror servera

V ESET Configuration Editor choďte nižšie a kliknite na Update module → 
Profile (My profile) → Setup → Update server: <Choose automatically>.  
Tu chceme nastaviť, aby sa klienti aktualizovali z mirror servera, ktorý sme 
si vytvorili v kroku 3.1. Keď je Update server vysvietený, kliknite na Mark na 
pravej strane, zvoľte <Custom update server> z položky Value a zadajte 
http adresu svojho mirror servera. Bude vyzerať takto:

http://Testserver: 2221.
(Kde Testserver je názov vášho servera a port 2221 je prednastavený port. Uistite sa, 
že nikde v celej http adrese servera nie sú medzery.)

Sekcia 4: .
Konfigurácia štandardnej politiky
ESET Remote Administrator vám umožňuje prispôsobiť si spôsob, akým ESET NOD32 
Antivirus / ESET Smart Security chráni vaše klientské počítače. Na tento účel je 
vhodné si vytvoriť štandardnú politiku (policy), ktorá bude distribuovaná na klientov 
spolu so samotnou inštaláciou bezpečnostného produktu ESET.

V konzole ESET Remote Administrator kliknite na Tools → Policy Manager. Uvidíte 
serverovú ikonku označenú menom vášho servera s názvom Server Policy. Kliknite na 
ňu a kliknite na Edit na pravej strane okna Policy Manager (obrázok 3-1, napravo). V 
tomto príklade je server pomenovaný ako Testserver.

Táto akcia otvorí ESET Configuration Editor – nástroj, pomocou ktorého upravíte 
nastavenia vášho klientského riešenia ESET Endpoint Antivirus / ESET Endpoint 
Security. 

Pre účely tohto sprievodcu nastavíme štandardnú politiku – súbor jednoduchých 
nastavení, ktoré fungujú na vačšine sietí. Ak máte špecifickú sieť alebo softvér, ktorý 
by vyžadoval špeciálne nastavenia, použite ERA Manuál pre vytvorenie prispôsobenej 
politiky.

Obrázok 3-1: Remote Administrator Console > Tools > Policy 
Manager

Odhadovaný čas:          15 minút

Obrázok 4-2: Remote Administrator Console > Tools > Policy 
Manager > Configuration Editor

ERA Príručka
Pre viac informácií si prečítajte v 
používateľskej príručke ESET Remote 
Administrator kapitolu:.
5.3 Politiky

Kliknite na ikonku diskety pre uloženie celej konfigurácie a kliknite na Console pre 
ukončenie programu Configuration Editor.

Obrázok 4-1: Remote Administrator Console > Tools > Policy 
Manager > Configuration Editor
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Odhadovaný čas: Závisí od zoznamu 
požiadaviek, počtu klientov alebo iných 
verzií antivírusových riešení,  
ktoré musia byť odinštalované.  
Maximálne 1 hodina.

Sekcia 5: Push inštalácia .
ESET Endpoint Antivirus / ESET Endpoint 
Security vo vašej sieti
Už máme nainštalovaný server aj konzolu a nastavený mirror server. Vytvorili sme si 
aj štandardnú politiku takže žiadne ďalšie úpravy nie sú potrebné.

Posledný veľký krok je dostať váš bezpečnostný softvér ESET na klientské stanice. 
Aby to bolo možné, ESET Remote Administrator vytvorí balík (inštalátor, ktorý môže 
byť spustený vzdialene) a pošle ho na každý počítač jednotlivo, aby administrátor 
nemusel fyzicky chodiť od počítača k počítaču a inštalovať ESET NOD32 Antivirus / 
ESET Smart Security manuálne.

Predtým, ako vytvoríte balíky a “pushnete” (odošlete) ich klientom, overíme si, či vaša 
sieť spĺňa podmienky pre vzdialenú inštaláciu.

5.1 Vyhľadanie klientov v záložke Remote Install a spustenie diagnostiky

Tento proces umožní ESET Remote Administrator identifikovať klientské stanice 
ktoré môžu byť zvolené pre push install.

Kliknite na záložku Remote Install v pravom spodnom rohu konzoly ESET Remote 
Administrator Console. Zvoľte sekciu Computers, kliknite na Default Search Task v 
okne Search Tasks a následne na Run. Klientské stanice zo záložky Clients sa objavia 
v sekcii Computers. Prečítajte si prepojenie s KB článkami na pravej strane pre 
inštrukcie ako vytvoriť užívateľskú úlohu na vyhľadávanie pre filtráciu výsledkov.

Podržte CTRL a kliknite na každého klienta pre ktorého chcete vykonať push 
inštaláciu. Po zvolení klientov kliknite pravým tlačidlom myši na jedného klienta a z 
kontextového menu vyberte Diagnostics of Windows Push Installation.

V okne Computers Logon Settings môžete nastaviť doménové prihlasovacie údaje 
pre každý počítač. Zvoľte klientský počítač(e) a kliknite Set alebo Set All, podľa toho či 
chcete údaje nastaviť jednotlivo alebo hromadne. Zadajte prihlasovacie údaje v okne 
Logon Informationm kliknite na OK a potom Next. Kliknite na Finish pre spustenie 
diagnostiky. 

Pre zobrazenie výsledkov diagnostiky, prejdite na záložku Install Tasks. Ak všetko 
prebehlo v poriadku, stav bude zobrazený ako “Finished” po skončení diagnostiky. 
Prejdite na sekciu 5,3 pre vytvorenie inštalačného balíka ak bola diagnostika úspešná. 
Ak sa zobrazí hláška “Finished With Warning”, prejdite na sekciu 5.2 pre vyriešenie 
problémov pred push inštaláciou.

5.2 Zoznam požiadaviek pre push inštaláciu

V tejto príručke predpokladáme, že vsetci klienti vo vašej sieti majú rovnaké sieťové 
nastavenia. Preto stačí skontrolovať tieto požiadavky u jedného klienta, potom by 
mali byť v poriadku aj tí ostatní.

Pre kompletný popis a zoznam požiadaviek konfigurácie pre push inštaláciu, prejdite 
na spojenie s KB článkami na pravej strane.

•	 Prvý, a možno najdôležitejší krok je overiť si, že všetky antivírové riešenia od iných 
výrobcov sú odinštalované na celej sieti. Dva paralelné antivírové systemy môžu 
spôsobiť, že systém bude nestabilný a môžu blokovať dôležité procesy ktoré 
musí váš ESET produkt vykonávať aby chránil vašu sieť. Viac informácií a zoznam 
bežných odinštalovacích nástrojov nájdete v KB článku na pravej strane.

•	 Všetky stanice kde chcete inštalovať ESET Endpoint Security / ESET Endpoint 
Antivirus musia odpovedať na ping z počítača kde je nainštalovaný ERA Server.

•	 Uistite sa, že Use simple file sharing (Recommended) je vypnuté na všetkých 
počítačoch v sieti s operačným systémom Windows XP a Windows Vista a 
všetkých serveroch s operačným systémom Windows Server 2000, 2003 alebo 
2008.

•	 Pre operačné systémy Windows Vista, Windows 7 a Windows Server 2008 overte 
nasledovné nastavenia:

•	 Služba ESET Remote Administrator service musí bežať pod účtom s právami 
Doménového Administrátora. 

Prepojenie s KB článkami
Prečítajte si KB článok na ESET Knowledgebase:

Požiadavky Push inštalácie ESET Remote 
Administrator a kontrolný zoznam

http://kb.eset.com/esetkb/SOLN82

Prepojenie s KB článkami
Prečítajte si KB článok na ESET Knowledgebase:

Nástroje na odstránenie najznámejších 
antivírusových produktov

http://kb.eset.com/esetkb/SOLN146

Prepojenie s KB článkami
Prečítajte si KB článok na ESET Knowledgebase:

Ako zobrazím špecifické typy skupín klientských 
staníc v konzole ESET Remote Administrator 
Console? (5.x)

http://kb.eset.com/esetkb/SOLN3020

Obrázok 5-1: Záložka Install Tasks

http://kb.eset.com/esetkb/SOLN82
http://kb.eset.com/esetkb/SOLN146
http://kb.eset.com/esetkb/SOLN3020
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•	 Pre nastavenie práv doménového administrátora pre ESET Remote 
Administrator, prejdite na Start → Control Panel → Administrative Tools → 
Services. Pravým tlačidlom myši kliknite na ESET Remote 	 Administrator 
Server service a zvoľte Properties z kontextového menu.

•	 Kliknite na záložku Log On a následne na tlačidlo vedľa možnosti This  
account. Zadajte meno a doménového administrátora do poľa This 	
account (napríklad: MyDomain\AdministratorAccountName) a potom heslo do 
koloniek Password a Confirm Password.

•	 Overte si, či klientské stanice môžu pristupovať na IPC zadaním nasledovného 
príkazu v príkazovom riadku na klientskej stanici: 
 
	 net use \\servername\IPC$
 
	 kde servername je názov vášho servera, kde je nainštalovaný ERA. 

•	 Overte si, že všetky klientské stanice majú aktivovaný administrative share 
(ADMIN$). Môžete ho nastaviť kliknutím na Start → Control Panel → Admin 
Tools → Computer Management → Shared Folders → Shares.

•	 Používateľ ktorý spúšťa inštaláciu musí mať administrátorské práva a nesmie 
mať prázdne heslo.

•	 Uistite sa, že sa z počítača kde je nainštalovaný ESET Remote Administrator 
Server môžete vzdialene prihlásiť na klientské stanice.

•	 Porty 2221-2224 musia povoliť ESET Remote Administrator-u komunikáciu. Ak 
má server ktorýkoľvek z týchto portov blokovaný, komunikácia s klientom nie je 
možná.

•	 V systéme Windows Vista/Windows 7 musí byť vypnutý User Account Control 
(UAC).

•	 Na klientských počítačoch s operačným systémom Windows musí byť spustená 
služba Remote Registry service.

5.3 Vytváranie balíka

Ak už sme si overili, ža naša sieť je pripravená na vzdialenú inštaláciu ESET Endpoint 
Antivirus / ESET Endpoint Security, musíme si vytvoriť inštalačný balík v konzole ESET 
Remote Administrator-a. Kliknite na Start → All Programs → ESET → ESET Remote 
Administrator Console. V spodnej časti hlavného okna ERAC kliknite na záložku 
Remote Install. V záložke Remote Installation Tools kliknite na Packages....

Pre pridanie balíka kliknite na Add... v okne Installation Packages Editor.

Kliknite na Save As pre uloženie balíka a dajte mu vhodné meno, napríklad “ESET 
Endpoint Security Install”. Kliknutím na Save a Close sa vrátite na hlavné okno ERAC.

Kliknite na Download From The Web, zo zoznamu vyberte inštalačné súbory 
ESET Endpoint Security / ESET Endpoint Antivirus a kliknite Create pre 
stiahnutie súborov a vytvorenie inštalačného balíka.

Obrázok 6-1: Okno vytvárania inštalačného balíčka

 
Prepojenie s KB článkami
Prečítajte si KB článok na ESET Knowledgebase:

Ktoré porty používa ESET Remote 
Administrator?

http://kb.eset.com/esetkb/SOLN2221

http://kb.eset.com/esetkb/SOLN2221
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5.4 Push inštalácia balíka

Teraz, keď máme inštalačný balík pripravený, vyberte vhodných klientov v ERAC 
a pošlite im ho. Aby ste im ho poslali, kliknite na záložku Remote Install v ERAC 
a zvoľte si klientov. Pravým klikom na klientov a zvolením Push Installation z 
kontextového menu sa balík odošle. Druhý spôsob je klinutie na Actions a následne 
Push Installation.

V okne Computers Logon Settings, ktoré vyskočí, môžte nastaviť doménové 
prihlasovacie údaje pre každého klienta. Vyberte jedného alebo viacerých klientov  
a kliknite na Set alebo Set All, podľa toho či nastavujete údaje pre jedného klienta 
alebo viacerých. Do vyskakovacieho okna zadajte prihlasovacie údaje a kliknite na 
OK. Kliknite na Next.

V nasledujúcom okne Package Settings zvoľte ESET Security Products package z 
roletového menu Type. Vyberte váš uložený balík (“ESET Endpoint Security Install” z 
kroku 5.2) z roletového menu Name.

Pomenujte svoju úlohu Remote Install task a nastavte čas kedy sa má úloha vykonať 
(okamžite alebo v špecifický čas) v okne Task Settings. Kliknite na Finish pre 
vytvorenie úlohy.

Po dokončení inštalácie kliknite na záložku Clients v spodnej časti hlavného okna 
ERAC a počkajte, kým sa sem prihlásia všetky počítače kam ste vyslali inštalačný 
balík. Ak sa všetky počítače, kam ste vyslali inštaláciu, objavia na pravej strane, vaša 
push inštalácia je hotová.

POZNÁMKA: Určití klienti môžu hlásiť chybu ohľadom aktualizácie okamžite po skončení 
inštalácie. Toto je spôsobené tým, že neprijali politiku vytvorenú v Sekcii 4. Tento problém sa 
vyrieši automaticky do hodiny.

5.5 Konfigurácia sieťových nastavení—len pre ESET Endpoint Security

Gratulujeme, práve ste úspešne dokončili push inštaláciu!

Ak ste na všetky stanice nainštalovali ESET Endpoint Antivirus, žiadne dodatočné 
nastavenia nie sú nutné. Pre zabezpečenie stabilnej komunikácie klientov, naktorých 
ste nainštalovali ESET Endpoint Security so serverom, nastavte možnosti popísané v 
nasledovných krokoch.

Okno New network connection detected sa objaví po prvom spustení ESET 
Endpoint Security. Kliknite na Allow sharing (umožniť zdieľanie) aby ESET Endpoint 
Security nedetegoval ESET Remote Administrator ako možnú hrozbu a neblokoval 
komunikáciu so serverom.

Štandardné nastavenie personálneho firewallu je  Automatický režim. Odporúčame 
ponechať toto nastavenie u klientov ktorí sa budú pripájať len do vašej siete aby sa 
zabránilo problémom v sieťovom spojení. 

Pre nastavenie personálneho firewallu klientov ktorí sa budú pripájať k verejným 
alebo iným sieťam si prosím pozrite používateľskú príručku ESET Endpoint Security. 
Pre stiahnutie používateľskej príručky kliknite na link nižšie: 

http://download.eset.com/manuals/eset_ees_userguide_sky.pdf

5.6 Ochrana vášho Microsoft Windows servera

Ak používate váš server na prehliadanie internetových stránok a/alebo 
spracovávanie e-mailov a je teda vystavený bezpečnostným hrozbám, odporúčame 
nainštalovať ESET File Security for Microsoft Windows Server.

ESET File Security for Microsoft Windows Server je optimalizovaný pre ochranu 
serverových systémov a nespôsobuje konflikty ktoré sa môžu objaviť pri 
nainštalovaní klientského riešenia ochrany na server. Pre viac informácií ohľadne 
ESET File Security for Microsoft Windows Server, prejdite na KB článok na pravej 
strane.

Ďakujeme, že ste si vybrali ESET!

 
Prepojenie s KB článkami
Prečítajte si KB článok na ESET Knowledgebase:

Často kladené otázky o ESET File Security for 
Microsoft Windows Server

http://kb.eset.com/esetkb/SOLN2789

Obrázok 8-1: Okno New network connection detected

Obrázok 7-1: Vyberte klientské počítače zo záložky Computers 
na pravej strane. Kliknite na ne pravým tlačidlom myši a zvoľte 
Windows Push Installation

Prepojenie s KB článkami
Prečítajte si KB článok na ESET Knowledgebase:

Ako vykonám push inštaláciu na klientské 
pracovné stanicie pomocou ESET Remote 
Administrator? (5.x).
http://kb.eset.com/esetkb/SOLN2982
 
Ako vzdialene odinštalujem klientov pomocou 
ESET Remote Administrator? (5.x).
http://kb.eset.com/esetkb/SOLN2991

http://kb.eset.com/esetkb/SOLN2789
http://kb.eset.com/esetkb/SOLN2982
http://kb.eset.com/esetkb/SOLN2991
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